3D structure visualization and high quality imaging.

Chimera

Vincent Zoete – 2008
Contact : vincent.zoete@isb-sib.ch
# Table of Contents

Presentation of Chimera....................................................................................................................3

Exercise 1.............................................................................................................................................4
  Loading a structure into Chimera...........................................................................................................4
  Moving / zooming.................................................................................................................................5
  Ribbon representation.............................................................................................................................5
  Coloring the secondary structure elements. The Model Panel..............................................................6
  Changing bonds and atoms display. Selections.....................................................................................7
    Selections using the select menu........................................................................................................7
    Changing bond display and color.......................................................................................................8
    Selections using the command line......................................................................................................9
  Changing ribbon attributes................................................................................................................11
  Calculating and showing hydrogen bonds..........................................................................................11
  Showing the ligand surface................................................................................................................12
  Label residues.....................................................................................................................................13
  Saving image..........................................................................................................................................13
  Saving the session status......................................................................................................................14
  Closing the session. Quitting Chimera................................................................................................14
  Restoring a previous session..............................................................................................................14

Exercise 2.............................................................................................................................................15
  Loading the macromolecular structure...............................................................................................15
  Showing the molecular surface of the protein.....................................................................................15
  Change the surface color.....................................................................................................................16
  Changing bonds and atoms display....................................................................................................16
  Clipping the protein.............................................................................................................................16
  Surface capping....................................................................................................................................18

Exercise 3.............................................................................................................................................19
  Open a previous session.......................................................................................................................19
  Using the side view..............................................................................................................................19
  Changing the Lighting.........................................................................................................................20

Going further..........................................................................................................................................21
Presentation of Chimera

This introductory course about 3D structure visualization and high quality imaging for publication will make use of the free program Chimera. The official website of chimera can be found at the following address: http://www.cgl.ucsf.edu/chimera

Here is a brief description of Chimera and its features taken from the website:

“UCSF Chimera is a highly extensible, interactive molecular visualization and analysis system. Chimera can read molecular structures and associated data in a large number of formats, display the structures in a variety of representations, and generate high-quality images and animations suitable for publication and presentation. In addition, Chimera provides tools to: show density maps and analyze microscopy data; utilize symmetry information for the display of higher-order structures; display multiple sequence alignments, with crosstalk between the sequences and structures; and enable analysis of molecular dynamics trajectories and docking results.

Chimera is distributed with full documentation and a number of tutorials, and can be downloaded free of charge for academic, government, non-profit, and personal use. Chimera is available for several platforms, including Windows, MacOS X, and Linux. For more information, see the Chimera web site. Chimera is developed and supported by the Resource for Biocomputing, Visualization, and Informatics and is funded by the NIH National Center for Research Resources (grant P41-RR01081). “

The program can be downloaded at the following address:
http://www.cgl.ucsf.edu/chimera/download.html

When using chimera, one should cite this reference:

The following exercises will be used as tutorials to introduce some basic commands of Chimera. The HIV-1 protease in complex with the A77003 inhibitor (1HVI in PDB) will be used as an example. You are highly encouraged to test the different options that you will encounter in the different menus.

Generally, scientific journals require EPS or TIFF images, with a 300 dots per inch resolution or higher, and with RGB colors. You will see how to obtain such images using Chimera.


**Exercise 1**

**Loading a structure into Chimera**

Two methods can be used to load a structure into Chimera.

1) If the structure file is present in the user's computer, choose the menu item “File/Open”. Then select “1HVI.pdb” and click “Open”.

2) The structure might also be fetched from a database, when available. Choose the menu item “File/Fetch by ID”. Choose the PDB databank and type the PDB code “1HVI”. Then click “Fetch”.

Under Unix or Mac OSX, the structure (for instance 1HVI.pdb) can also be loaded using the following command:

```
> chimera 1HVI.pdb
```
Once the structure has been loaded, all macromolecule's bonds should appear in the “wire” representation, which is Chimera's default.

Moving / zooming

The macromolecule can be rotated by clicking the left button and dragging the cursor over Chimera's window. The translation is obtained similarly, but using the central mouse button. Finally, one can zoom in and out using the mouse right button.

**Rotate**: press left button and drag  
**Translate**: press central button and drag  
**Zoom**: press right button and drag

Command line…”

Most of Chimera functionalities can be accessed by typing a given command in the “Command line”, which is situated at the bottom of the Chimera window. If the command line is not present, display it using “Favorites/Command Line”. A line preceded by “Command” will appear on the lower part of the principal window. Examples of how to use the command line will be given later.

Ribbon representation

The secondary structure elements can be shown using the ribbon representation. This can be accessed through the “Actions/Ribbon” sub-menu.
One convenient feature of Chimera is its ability to detach sub-menus so that one can use them several times without the need to go again through the different menus. For instance, choose the “Actions/Ribbon” menu item, and click on the dotted line at the top of this sub-menu. The sub-menu will be detached and freely movable.

![Chimera sub-menus illustration](image)

The ribbon representation of the secondary structure elements can be switched on by choosing “show” in the “Ribbon” menu. Three variants are available: “flat”, “edged” and “rounded”. You can try them all by clicking the corresponding menu item. Select the representation you prefer.

![Ribbon representation illustration](image)

**Important**: type “ksdssp” in the command line to recalculate the secondary structure elements of the protein. This uses an implementation of the Kabsch and Sander algorithm for defining the secondary structure of proteins.
Coloring the secondary structure elements. The Model Panel

The ribbon can be colored according to the secondary structure element, i.e. strand, helix or loop. Open the Model Panel by choosing the “Tools/Depiction/Color Secondary Structure” menu item. This will open the “Color Secondary Structure” window. Check the “Helix”, “Strand” and “Other” boxes. For each one, it is possible to modify the default color by clicking on the corresponding colored square to open the “Color Editor” window and change the RGB cursors positions. Click on the “Apply” button of the “Color Secondary Structure” window to apply the coloring.

You can try several color combinations and keep the one you prefer. Finally, you can close the “Ribbon”, “Color Secondary Structure” and “Color Editor” windows by clicking the “Close” button, or the top right “X” icon.

Changing bonds and atoms display. Selections

The objective of this part is to display only the ligand, the active site water molecule and residues 25 and 50 of the HIV-1 protease. Other residues will be hidden to clarify the figure. This will require to select parts of the structure and apply them different representation schemes.

There are three ways of selecting atoms with Chimera: using the “Select” menu, using the “Command Line”, and using the mouse to select atoms from the screen. The latter will be described later.


Selections using the select menu

Open the “Select” menu and detached it by clicking on the upper dotted line. Verify that the “Selection Mode” is “replace”. Otherwise, choose it.

The first four menu items allow to select part of the structure according to the “Chain” (protein chains, ligand, water), the “Chemistry” (chemical nature of the atoms or functional groups), the “Residue” (residue name or type) and the “Structure” (backbone, side chains, secondary structure, etc...). You can try to select different parts of the complex. For instance, you can select the ligand by choosing the “Select/Chain/het” menu item. You will see that the selected parts of the structures are surrounded by green thin lines.

Note that this HIV-1 protease inhibitor is also defined by its “ligand” nature or its residue name (i.e., A77). Therefore, it can be selected also by “Select/Structure/ligand” or “Select/Residue/A77”.

You can try selecting different parts of the complex: the water molecule, chains A or B of the protein, the aspartate residues, the strands, etc...

It is possible to append a selection with a new one. For instance, to select all the protein, you can choose the menu items “Select/Selection Mode/append”, then “Select/Chain/A” and “Select/Chain/B”.

Finally, you can clear all selections using “Select/Clear Selection”.

Changing bond display and color

Select the “replace” mode for selections using “Select/Selection Mode/replace” and select the ligand.

Open the “Actions/Atoms Bonds” menu and detach it by clicking on the upper dotted line. Choose successively the “stick”, “ball and stick”, “sphere” and “wire” menu item sand see how the ligand is displayed in each case. Finally, choose the “ball and stick” representation.
Open the “Actions/Color” menu and detached it by clicking on the upper dotted line. You can eventually close some other windows to save space on the screen. Check the “atoms/bonds” box so that the color changing will be applied only to atoms and bonds. Then, you can select a color from the left column that will be used for all ligand atoms. Another possibility is to color all atoms according to their atom types. This is obtained by clicking “by element”.

Similarly, select the water molecule, display it in ball and stick and color it according to the atom types.
Selections using the command line

Close the “Select” window using the upper right “X” icon. If it's not already done, open the command line by choosing “Favorites/Command line”. A line preceded by “Command” will appear on the lower part of the principal window. This line can be used to type and execute commands relative to selection and display, for instance. To execute a command, one needs to type it in the command line and press Return. The union and intersection selection keywords are noted “|” and “&”, respectively. The negation symbol is “~”.

A detailed description of the different selection possibilities using the command line are provided in the quick reference guide. Here is a limited list showing some possible selections based on our particular structure that you could try:

```
“select” : select everything.
“select :.A” : select chain A of the protein.
“select :.A,.B” : select chains A and B of the protein.
“select ligand” : select the ligand.
“select :A77” : select the residue named A77. Another way to select the ligand.
“select :HOH” : select the residue named HOH, i.e. the active site water molecule in our case.
“select :HOH | ligand” : select both the water molecule and the ligand.
“select :25” : select all residues that are numbered 25 in the PDB. One in both chains.
“select :25@CA” : select atom Cα of residues 25.
“select :25.A” : select residue 25 of chain A.
“select :25,50” : select all residues that are numbered 25 and 50 in the PDB.
“select strand” : select strands.
```

Select all the protein by typing “select :.A,.B” in the command line, and hide the atoms and bonds using “Action/Atoms bonds/hide”.

Select residues 25 and 50 by typing “select :25,50” in the command line, and show them in ball
Changing ribbon attributes

As can be seen, the backbone atoms of the protein residues are not shown, while the bond lengths between the backbone (displayed as a ribbon) and Cβ atoms are artificially too long. This is due to the default behavior of Chimera that hides backbone atoms when ribbons are displayed. This can be modified by changing some “attributes” of the structure. From the “Model Panel”, open the “attributes” window, and choose the “false” value for “ribbon hides backbone atoms”.

Calculating and showing hydrogen bonds

Chimera can calculate and display the hydrogen bonds between selected atoms. To show the hydrogen bond network between the ligand, the active site water molecule and the Ile50 backbone atoms, the following sequence of actions can be used. Select the active site water molecule (using
the command line or the “Select” menu). Open the “Tools/Structure Analysis/FindHBond” window. Check the “Only find H-bonds with” box, so that it will calculate only hydrogen bonds involving the active site water molecule. Finally, click on the “Apply” button.

You can change the hydrogen bond color and line width from the “H-Bond Parameters” window, and click “Apply” to apply them.

**Showing the ligand surface**

Select the ligand. Then, open the “Surface” window using “Action/Surface”. Click “show”. You can try modifying the surface representation to “mesh” and “dot”. Then, go back to the “solid” representation.

The surface quality may be increased by changing the corresponding attribute. In the “Model Panel” window, select the MSMS ligand surface in the left list. Then click “attributes” and change the “vertex density” attribute to 10. Press Enter to apply the change.

This surface gives a good idea of the volume occupied by the ligand. However, it also hides the
molecule. To correct this, it can be made transparent. In the “Surface” window, click on “transparency” and select 80%.

Label residues

Select atoms Cβ of residues 25 by typing “select :25@CB” in the command line. Open and detach the “Label” window by choosing the “Actions/Label” menu item. In the “Label” window, choose “residue/name + specifier”. You can try other types of labeling. Eventually, you can change the label color using the “Color” window, checking “residue labels” and choosing a color.

Saving image

Clear all selections using “Select/Clear Selection”. Choose an orientation and zoom that provides a satisfying point of view. Then, select the “File/Save Image” menu item. In the new window, choose an image resolution of 300 dots per unit (dpi). Select “Maintain current aspect ratio”, and
enter an “Image width” of 6 inches. Click “Save As”. Wait while the image is calculated. Select the format of the file that will be saved. Scientific journals generally accept TIFF and EPS files. Select TIFF in this case. Finally, choose and “File name” and click “Save”.

Images are saved as RGB figures.

**Saving the session status**

The Chimera session (the actual representation) can be saved for future use or modifications. This can be made using the “File/Save Session As...” menu. Select a file name and click “Save”. The saved file is actually a python script and will have the “.py” extension.

**Closing the session. Quitting Chimera**

The session can be closed using the “File/Close Session” menu item. One can quit Chimera with “File/Quit”.

**Restoring a previous session**

A previously saved session can be restored using the “File/Restore Session” menu item. Select the file (with a .py or .pyc extension) and click “Open”.

- 14/27 -
Exercise 2

Loading the macromolecular structure

Load the 1HVI.pdb structure file into Chimera using one of the two methods seen in exercise 1.

Showing the molecular surface of the protein

First, hide the bonds and atoms of the protein chains and keep only the ligand and active site water molecule visible. To do so, select the two protein chains, for example by typing “Select :.A,.B” in the command line. Then open and detach the “Action/Atoms Bonds” menu and choose the “hide” menu item.

![Image of protein structure]

Be sure that the protein is still selected. If necessary, or in case of doubt, select it again as described above. Then, open and detach the “Action/Surface” menu, and choose “show”. Open the “Favorites/Model panel” menu, select the “MSMS main surface” in the left list, then click “attributes” and change the “vertex density” to 10. If your computer is too slow, it might be necessary to reduce the vertex density to 5.
Change the surface color

Be sure that the protein is still selected. Open and detach the “Actions/Colors” menu. Check the “surfaces” box, and click on the color you would like to apply to the protein surface. The following image has been obtained using the cornflower blue color.

Changing bonds and atoms display

Select the ligand and water molecules, then display them in ball and stick representation, colored according to the atom type.
Clipping the protein

It is possible to cut the protein surface in to get a better view of the ligand binding mode inside the binding site. To do so, open and detach the “Tools/Depiction” menu. Then choose the “Per-model Clipping” menu item. In “Model”, select the “MSMS main surface” and check the “Enable clipping” box. Rotate the structure to get a better view of the clipping effect.

It is possible to manipulate the clipping position using the mouse. Check the “Adjust clipping with mouse” box. A click/drag of the mouse central button will control the translation of the clipping plane. A click/drag of the mouse right button will modify its orientation. Note that this cancel any possibility of protein translation or zoom using the mouse. You can get back to the default behavior of the mouse by unchecking the “Adjust clipping with mouse” box.

You can select and display residues 25 and 50 of the HIV-1 protease by typing “select :25,50” in the command line, and then display them in the stick representation. Then change the position and
orientation of the clipping plane to have a good view of the interactions between these residues and the ligand.

You can also get a good view of the shape of a buried binding site using the slab mode. In the “Per-Model Clipping” menu, check the “Use slab mode with thickness” and choose 6 for the thickness. This creates a protein slab that you can manipulate using the mouse by checking the “Adjust clipping with mouse” box.

Uncheck the “Use slab mode with thickness” box.

Surface capping

A clipped surface may be capped. To do so, choose the “Surface Capping” menu item in the “Depiction” window. In the “Surface Capping” window, check the “Cap surface at clip planes” box. You can change the color of the capping plane by checking the “Use cap color” box and
choose the color by clicking the colored square next to it.

This capping can also be applied with the slab mode.

Save an image as described in the previous exercise, then save the session and close it.
Exercise 3

Open a previous session

Open the final state of exercise 2 using the “File/Restore Session” menu. Removing all clipping and capping, and change the background color to black if necessary.

Using the side view

Open the “Viewing” menu by choosing the “Favorites/Side view” menu item. The “Side View” tab of the “Viewing” window should be active. Otherwise, click on the “Side View” tab. You will see a reduced view of the structure appearing in the “Viewing” window. The vertical lines shows the clipping planes that define the region of space displayed on the screen. The square gives the viewer's eye position. The red lines show the field of vision.

Clicking the “View All” button adjusts the scale and clipping plane positions so that the view will include everything that is displayed. It is possible to move the position of the viewer's eye and clipping planes using the mouse.

If you draw the rear clipping plane closer to the protein, you will see the effect of the depth cueing, which causes regions farther from the viewer to be shaded. The depth cueing parameters can be changed in the “Effects” tab of the “Viewing” window.
Changing the Lighting

It might be useful to change the lighting (intensity and direction) to get a better view of the system. Select the “Lighting” tab in the “Viewing” window. This tab displays the light sources and parameters. The key light is the dominant brighter source of light. The fill light gives a secondary source. The solid arrows in the right view allow to manipulate the lighting directions with the mouse. You can try different lighting directions to see their effect.
Exercise 4

Loading the macromolecular structures

Load the 1HVI.pdb structure file into Chimera using one of the two methods seen in exercise 1. Then open the 1HII.pdb structure file. These structure files correspond to the HIV-1 and HIV-2 proteases, respectively.

They are now two active models mentioned in the lower line of the main Chimera window. Model 0 is HIV-1 protease (1HVI), whereas model 1 is HIV-2 protease (1HII). Display both molecules using different colors. For this, each model can be selected subsequently by typing “select #0” and “select #1” in the command line.

Showing the proteins as ribbons

Select all heteroatoms and water molecules by typing “select :het | :HOH” in the command line, and delete the corresponding atoms using “Action/Atoms bonds/delete”. Only the two proteins are remaining in Chimera. Display them in ribbon representation, as explained in exercise 1. Hide bonds for both molecules. Recalculate the secondary structure elements by typing “ksdssp” in the command line.
Match the two molecules. Obtain a structural alignment

Open the structural alignment tool using “Tools/Structure Comparison/MatchMaker”. Click on “Specific chain(s) in reference structure with specific chain(s) in match structure”. Then, select chains A and B of 1HVI as reference structures, and match them with chains A and B of 1HII, respectively. Select the “Needleman-Wunsch” algorithm and click “OK”. This will perform a matching of the two molecules, based on their sequence and 3D structure similarities.

After a short moment, the two molecules should be superimposed. A new window, called “MultiAlignViewer” will also appear, showing the corresponding sequence alignments.
The percentage of sequence identity between the two molecules can be obtained using the menu “Tools/Percent identity...” of the MultiAlignViewer window. The results appear in the Chimera command line.
The secondary structure elements can be highlighted in the sequence using the MultiAlignViewer command: “Structure/Secondary Structure/show actual”. Secondary structure elements appear in green for β-strands and yellow for α-helices.

Isolated residues or groups of residues can be selected by clicking over the sequence or in the “Conservation” line of the MultiAlignViewer, allowing the analysis of the proteins structural differences or analogies.
It is possible to color the structures according to the percentage of conservation in the sequence alignment. For this, open the “Structure/Render by Conservation” menu of the MultiAlignViewer, then click “Apply” using the default values for the different options. In the present case, the most conserved regions are colored in red and the less conserved ones in blue.
Going further

These exercises give only a very limited overview of what Chimera is able. You can find a detailed documentation, as well as some tutorials, at the following address:
http://www.cgl.ucsf.edu/chimera/docindex.html

Here are some examples of images produced using Chimera that were taken from the official Website.

- Sliced potassium channel
- Paramecium Bursaria Chlorella Virus
- DNA and Netropsin
- Bluetongue Virus and Viral RNA